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Electronic Reporting 

Regional Collection Centers are at the forefront of  a bureau 
initiative to enable permitted facilities to submit required reports via 
the internet. 

egional Collection Centers are the first of the solid waste permitting programs 
to implement electronic reporting for standard reporting forms.  The 
electronic reporting program began with the September 1, 2009 submittal, 
coordinated with the beginning of the 2009 reimbursement period.  Facilities 

are strongly encouraged to use the electronic reporting system.  Submitting required 
reports via the internet reduces the amount of data entry necessary to calculate 
reimbursement payments, resulting in more accurate and timely reimbursement for the 
Centers‟ disposal costs.  The reduction in duplicative data entry also reduces the 
potential errors in the Department‟s Annual Household Hazardous Materials 
Legislative Report and other data queries.  

How to use this Manual 

This Help Manual will help guide you through the process of 
entering a new report, editing a saved report, submitting a saved 
report, and viewing past submittals and statewide data.  The 
“icon key” at left displays symbols that denote special items in 

the text of the manual.  Items marked with these symbols will contain helpful hints or 
other important information you‟ll need to successfully submit an electronic report.   

Before you Begin

Who to contact for access to the site 

Access to electronic reporting is restricted to those persons 
responsible for submitting Regional Collection Center reports for a 
facility.  Access can be requested by contacting the department‟s 
Regional Collection Center environmental specialist or permit 
engineer. 
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 Contact Information 

 Internet Links 

 Helpful Hints 
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Technical Requirements 

Electronic reporting is done through an internet web application.  
Users must have a computer connected to the internet and use any 
standard web browser (e.g. Internet Explorer or Firefox).  A high-
speed internet connection is recommended, but not necessary.   

 

Pop-Up Windows 

In some cases, the web application will try to display information in a new window or 
tab in your browser.  This will not function properly if pop-up windows are disabled.  
You may see a message stating “Allow pop-up windows for this site?”.  If so, 
please click Yes. 

To change your internet settings to permanently allow pop-up windows for this web 
application, follow this instructions: 

Internet Explorer Firefox 

Go to Tools > Internet Options Go to Tools > Options… 

Click on the Privacy tab Click on the Content tab 

Under the Pop-up Blocker heading, 
click the Settings button 

Next to “Block pop-up windows”, 
click the Exceptions button 

In the text box under “Address of 
website to allow”, type 
programs.iowadnr.gov, then click Add 

In the text box for “Address of web 
site”, type programs.iowadnr.gov and 
then click Enable 

Click Close to close the Settings window 
and click Apply to save the new settings 

Click Close to close the Allowed Sites – 
Pop-ups window and OK to save the 
new settings. 

 

Instructions, where applicable, are given for Internet Explorer 7.0 and Firefox 3.0.   

 


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Process Overview 

The Solid Waste web application allows you to create, edit, and 
submit reports online.  

 

Deadlines 

Reports are due March 1st and September 1st of each year. To 
complete submission by the deadline you must print and mail a copy 
of the Certification Letter along with all required documentation 
attached.  Late submissions will forfeit their reimbursement (IAC 
567-221.9.1(d)). 

User enters draft Semi-
Annual Report online

User submits Semi-
Annual Report 
electronically

User prints and mails 
certification letter and 

required supporting 
documentation

DNR reviews electronic 
submission and 

supporting documents

DNR approves 
electronic submittal

Reimbursement 
payments are 

calculated based on all  
report submissions

Chapter 
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How to Enter a Report 

Users can create a new report, save their work, and return to edit 
the information at a later time.

ogin credentials (username and password) will be issued to the report contact 
for each Regional Collection Center.  When the credentials are issued, the 
contact will receive an email informing them that the username and password 
are set and ready for use.  The email also contains a link to the login page.  This 

email is automatically generated when the user is set up in the application.  Do not 
reply to the email.   

 

Solid Waste Database URL 

The Solid Waste Permitting Database can be found at 
https://programs.iowadnr.gov/solidwaste/.  Use the link in the 
lower left column, Administrative Login, to access the login 
screen.   
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Logging In 

The password provided in the email is a temporary password and you will be required 
to change it the first time you log in.  The new password must be at least 7 characters 
in length and different from the old password.   

  

If you forget your username and/or password, you can use the Forgot Password link 
on the login page to have them emailed to you.  After you have retrieved your user 
credentials in this way you will be required to change your password. 
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Take note of your environment 

The basic page layout in the application includes: 

 DNR Waste Management header logo 

 Left-hand column that shows your name, the current 
date, a logout button, and quick links to other sections of the application 

 Large right-hand column that is the main focus for your work.  

 

Tips For Success #1: Be Prepared 

Before you start to enter any data, make sure you have all the 
information you need.  You can always save what you have and 
return later to fill out the rest but it‟s much easier to have the 
information all together using a paper copy of the forms if necessary 
to keep notes. 

Entering a Regional Collection Center report consists of completing three forms.  
Each form leads to the next.  When you have finished the third form you will be 
directed back to the menu.   You will be automatically logged out if you spend too 
much time without saving the form.  The application will send you back to the 
login page with a message that your session has expired.  The Collection Report 
has a warning message that will pop up and allow you to extend your session 
before it expires. 

Create a New Report 

To begin, click the link Begin New Report in the Facility Reports Menu.  This will 
bring up a three question form where you will indicate the type of report, permit 
number, and reporting period for which you wish to start a new report.   




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Tips For Success #2: Enter information in order 

Forms with numerically ordered questions generally need to be 
answered in sequential order.   

 

 

 

Once you have selected a Report Type (Regional Collection Center Semi Annual 
Report), the Permit Numbers for which you have access to enter that type of report 
will appear.  After you have selected a Regional Collection Center, a list of reporting 
periods will appear.  Only reporting periods which have not had a report created will 
appear in the list.  When you‟ve made all your selections, click Begin.  Note:  If you want 
to edit an existing report, see Edit a Draft Report. 

The Report Form 

The electronic Regional Collection Center semi-annual report consists of three 
sections: Regional Collection Center Attributes, Semi Annual Report, and Collection 
Report. 

Tips For Success #3: Report Form Layout 

At the top of each section there is a header section.  Double check 
here that you have selected the correct reporting period.  Basic 
information regarding the Regional Collection Center‟s permit is also 
displayed. 

 

Regional Collection Center Attributes 

Attributes are questions that help describe the facility and typically don‟t change from 
report cycle to report cycle but still should be reviewed by the facility for accuracy.  The 
only attribute needed for Regional Collection Centers is the Service Area 
Description.  Since this doesn‟t change often, the current information known by the 
Department will be displayed.  Make changes if necessary and click the Save and 
Continue button to go on to the next section. 
 

 

  




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Semi Annual Report 

The Semi Annual Report section directly corresponds to the Word document portion 
of the hard-copy semi-annual submittal.  Totals are automatically calculated for you (do 
not use commas or dollar signs). Click on the Save and Continue button to go on to 
the next section.    
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Collection Report 

The Collection Report section directly corresponds to the Excel spreadsheet portion of 
the hard-copy semi-annual submittal.  Totals are automatically calculated at the end of 
each row and column as well as the cumulative totals at the bottom of the form.  Do 
not use commas or dollar signs when entering numbers. 

 

Tips For Success #4: Use TAB to move between textboxes 

Unfortunately, unlike the Excel spreadsheet version of this form, 
you cannot use the arrow and enter keys to move between “cells.”  
Instead, use the TAB key and your computer mouse to move 
between textboxes.  This also highlights the contents of each 
textbox for easy overwriting of the default 0s. 


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You cannot “freeze” the row and column headings to stay in view as you move 
through the form like you could in Excel.  There are a couple different options for 
shrink the form so that more of it can be in view at the same time: 

 Hold down the CTRL key while scrolling the middle wheel on your mouse 
to zoom in and out on the form. 

 Change the display settings on your monitor to a higher resolution. 

 In Firefox, select Zoom from the View menu. 

The Collection Report section is the final section of the report.  Click Finish Draft to 
save the section.  The application will return you to the Facility Reports menu and 
report that you have saved the completed draft report.  At this point you can submit 
the report (see Chapter 4) or revisit the report at a later time to revise the information 
(see Edit a Draft Report below).  Don’t forget to submit the report before the 
report’s due date. 

Edit a Draft Report 

Each section of the Regional Collection Center semiannual report is saved separately.  
If you are called away in the middle of entering the report or enter everything and then 
want to double-check your figures before submitting, you can use the Edit Draft 
Report link in the Facility Reports Menu to view and edit the draft. 

 

Only those report periods for which you have a draft report started will show up under 
Report Period.  Once you are confident you have complete and correct information 
entered for reporting period it‟s time to submit the report to DNR. 
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Tips For Success #5: Don’t forget to SUBMIT your report 

When you have completed the draft submittal the application will 
return to the Facility Reporting menu.  Your draft report does not 
become your official submittal until you go through the steps in the 
Submit Report to DNR form.  See Chapter 4 for more information. 

 

 

 

 


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How to Submit a Report 

Once you have completed a draft report there is one final step – 
submitting the report.  This is the online equivalent of  putting the 
report in an envelope and mailing it to the Department.

eports are due March 1st and September 1st of each year.  IAC 567-221.9.1(d) 
requires that a complete submission be received by the reporting deadline or 
any reimbursement for that time period will be forfeited.  A complete 

electronic report submission includes 

 Submission of electronic data using the Submit Report to DNR form 

 A signed paper copy of the certification letter generated by the electronic 
submittal 

 Documentation (receipts, shipping manifests, invoices, etc) for material listed 
in the Collection Report 

Submit Report to DNR form 

You will find the link to submit reports to DNR under item #3 in the Facility Report 
menu.  A form will appear for you to select the type of report, permit number, and 
reporting period.  After making the appropriate selections, click  Submit Report to 
complete the submittal.   

 

Chapter 
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Tips For Success #6: Reports are locked after submittal 

After submitting a report you are not allowed to make any additional 
changes to that report and cannot create a new report for the same 
time period.  If the Department reviews the report and finds 
changes are necessary, staff will unlock the report submission and 
notify you to make the changes using the Edit Draft Report form 

and resubmit.  This will make a second submittal for the same time period and does 
not replace the original submission.  Each submittal is preserved but only the final 
submittal as approved by the Department will be used to calculate reimbursements. 

Confirmation  

When the official submittal is successfully transmitted, you will receive a 10-digit 
confirmation code.  You may print a copy of this screen for your records, but a copy of 
will also be emailed to you.  The confirmation code and date/time of electronic  
submission will also be displayed on the certification letter and report forms.  

 

 

 

 

  

Tips For Success #7: Enable Pop-up Windows 

The confirmation screen (shown above) has links to the certification 
letter and the report forms you submitted.  These links will open in a 
separate window or tab.  If the links will not open for you then you 
may have pop-ups disabled.  A detailed description of how to enable 
pop-up windows is provided in Chapter One. 

 





Confirmation Screen Confirmation Email 
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Certification 

The certification letter must be printed, signed, and mailed to the Department along 
with all required documentation.  Sign the certification letter in the space next to the 
Name of Person Certifying as you would on the paper form. 

 

The certification letter and documentation are to be mailed by the deadline to the 
Department: 

 
Iowa Department of Natural Resources 

ATTN: Kathleen Hennings 
502 East Ninth Street 

Des Moines, Iowa 50319 

  


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Viewing Past Reports 

View your past report submittals and information from other 
Regional Collection Centers at the click of  a button.

acility Reporting menu link View Past Report Submittals provides access to 
all previous report submittals for Regional Collection Centers for which you 
have permission to view.  In addition, the Facility Reporting menu link View 

Cumulative Reports provides access to statewide information based on approved 
report submittals for all facilities.   

View Past Report Submittals  

After selecting the report type and permit you wish 
to view, a list of all available report submittals will 
appear.  Those submittals that are approved will be 
marked with APPROVED next to the report 
period.  In the example given at left you can see the 
user had to submit the January – June 2009 report 
twice and the second submission was approved by 
the Department.  Also note, if you accidentally 
delete the confirmation email with the link to the 
certification letter, you can access the certification 
letter again from here as well. 

 

 

Tips For Success #8: Printing in Landscape 

Some forms, such as the Collection Report, will print best in 
landscape.  To print in landscape, select Print from the File menu 
(or press CTRL-P).  Choose the printer you wish to print to, then 
click the Preferences (Internet Explorer) or Properties (Firefox) 
button.  Then switch the orientation from Portrait to Landscape 
and print the report. 

Chapter 
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View Cumulative Reports  

The Cumulative Reports section contains approved report information from all 
Regional Collection Centers.  Those facilities that do not choose to use the online 
reporting feature will have their reports entered by Department staff.  However this 
may delay the availability of reimbursement calculations since all reports must be 
entered before staff can determine reimbursement allocations.   

To view the cumulative reports, first you will need to select the report type and report 
period you wish to view: 

 

The information used in the cumulative reports is from approved report submittals.  
Some cumulative reports will not display correctly until all Regional Collection Centers 
have entered their reports and the Department has determined funding for the report 
period.  The Individual Reports section will show the report for the user that is 
currently logged in.  Information from other Regional Collection Centers can be 
viewed through the cumulative reports. 
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Budget/Reimbursement Summary 

This report contains five tables: Funding, Expenses, Reimbursement, Households & 
CESQGS & Revenue, and Pounds Received. Data is displayed for the selected time 
period (shown at the top of the report) and is drawn from four sources: RCC Semi-
Annual Report Forms, RCC Reimbursement Report Forms, and funding information 
and reimbursement amount information both of which are entered by DNR staff. 
Account information is which account your reimbursement is coming from (mandated 
by law) and funding is how much is available during that time period for 
reimbursement.  Where applicable, data is displayed for each RCC with a total at the 
end of the table. 

Data Columns Funding 

G593 

Total 

 

Expenses 

RCC Name 

Disposal 

Salaries 

Equipment/Supplies 

Overhead 

Public Ed/Advertising 

Training 

Capital/Building 

Other 

Satellites 

Total Operating Cost 

Brown Goods 

E-Waste 

Reimbursement 

RCC Name 

Total Pounds Collected 

Eligible Pounds 
Collected 

Percent of Total 
Eligible Pounds 

G593 

Sum of Reimbursement 

Households & CESQGS 

RCC Name 

Number of Households 

Total Household Pounds 

Pounds Per Household 

Household % of Total 
Pounds 

Number of CESQGs 

Total CESQG Pounds 

Pounds Per CESQG 

CESQG % of Total Pounds 

Total Pounds 

Revenue & Pounds Received 

RCC Name 

Revenue: Satellites 

Revenue: CESQGs 

Revenue: Swap Shop 

Revenue: Totals 

Pounds Rec’d: Permanent Facility 

Pounds Rec’d: Satellite 

Pounds Rec’d: Mobile Collection 

Pounds Rec’d: Total 
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Waste Collection Totals 

This report is shows total waste collection information from all RCCs who submitted 
reports. Data is displayed for the selected time period (shown at the top of the report) 
and is drawn from RCC Reimbursement Report Forms. 

Data Columns Hazard Class or Division 

Name of Disposal Contractor for Each Category 

Conversion Factors 

Products Distributed Through a Reuse Exchange Program 

Hazardous Waste contracts for a disposal cost: Recycled HW 

Hazardous Waste contracts for a disposal cost: Fuel Blending HW (Energy Recovery) 

Hazardous Waste contracts for a disposal cost: Incinerated HW 

Hazardous Waste contracts for a disposal cost: Landfilled HW 

Wastes not disposed of through HW Contractor: Recycled 

Wastes not disposed of through HW Contractor: Fuel Blending (Energy Recovery) 

Wastes not disposed of through HW Contractor: Landfilled as non-hazardous MSW 

Total Pounds Collected 

- - - - 

Total Hazardous waste collected 

Shaded areas are not included in hazardous material collection totals 

Total Managed 

Eligible for Reimbursement 

Eligible for Reimbursement: Recycled HW 

Eligible for Reimbursement: Fuel Blending HW (Energy Recovery) 

Eligible for Reimbursement: Incinerated HW 

Eligible for Reimbursement: Landfilled HW 

SWAP Shop 

Managed Locally 

Swap and Managed Locally 
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Reimbursment (Actual) 

This report is displayed for the selected time period (shown at the top of the report) 
and is created from reimbursement amount information entered by DNR staff. 

This report‟s accuracy depends on the following condition: 

• Reimbursement information for all RCCs must be entered in the Reimbursement 
Amount form for the time period  

HINT--(Wait until everyone has submitted before you look at this one!) 

Data Columns Funding 

G593 

Total 

 

Reimbursement Due For Calendar Year 

RCC Name 

Eligible Pounds: Jan-Jun 

Eligible Pounds: Jul-Dec 

Eligible Pounds: Total 

Eligible Pounds: Percent of [Grand] Total 

G593: Calendar Year Share 

G593: Jan-Jun Funds Received 

G593: Jul-Dec Funds Received 

Total Funds Received 

 

Households per RCC 

This report displays households for the selected time period (shown at the top of the 
report) and is drawn from individual Semi-Annual Report Forms and household 
census data stored in the database. The „Service Area‟ column reflects the RCC‟s 
answer to the question on its service area on the form. The „Counties Covered‟ column 
shows a listing of all counties whose household data is included in the „Households‟ 
column. 

HINT: If you have added a county to your service area, you may need to check this 
form to make sure the change is noted here. 

Data Columns RCC Name 

Service Area 

Households 

Counties Covered 
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Swap/Reuse/Exchange 

This report is displays the selected time period (shown at the top of the report) and is 
drawn from RCC Semi-Annual Report forms and Reimbursement Report forms for 
each RCC. Where applicable, data is displayed for each RCC with a total at the end of 
the table. 

Data Columns RCC Name 

Swap? 

Number of Households 

Swap Pounds 

Swap DOT & oil-based Paint 

Total HW Pounds 

% of selected hazardous waste pounds 

Type 

Charge 

Revenue 

Estimated Savings 

Do they utilize Volunteers? 

Do they recycle/reuse on-site? 

Are they planning to expand? 

How will they expand? 

 

E-Waste 

This report is displays E-Waste data for the selected time period (shown at the top of 
the report) and is drawn from RCC Semi-Annual Report for each RCC. Where 
applicable, data is displayed for each RCC with a total at the end of the table. Note that 
this report has been altered from the original Excel template to include all E-Waste 
data now collected.  

NOTE: This is not a required part of the report, so some RCC‟s do not elect to fill this 
out, but rather report their electronic numbers on their Annual CRT Permit report. 

Data Columns RCC Name 

Cost of disposal 

Total E-Waste Operational Expenses 

E-Waste Revenue 

Revenue loss/gain 

Pounds Managed 

Disposal Cost/Lb 

Operational Cost per Lb 

Net loss per Lb 
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VOC calculations (FY basis) 

This report displays VOC calculations for the fiscal year that the selected time period 
falls within (fiscal year is noted at the top of the report) and is drawn from RCC Semi-
Annual Report forms for each RCC. A separate table is displayed for each RCC. 
Subtotals are provided for DOT Classes and for Paint/Oil as well as a grand total at 
the bottom of each table. 

Data Columns RCC Name 

Material Name 

Pounds of Material (without SWAP) 

Pounds of Material (with SWAP) 

Pounds of VOCs (without SWAP) 

Pounds of VOCs (with SWAP) 

 

Yearly Total – Calendar Year 

This report contains two tables. Data is displayed for the selected time period (shown 
at the top of the report) and is drawn from three sources: RCC Semi-Annual Report 
Forms, RCC Reimbursement Report Forms, and reimbursement amount information 
entered by DNR staff. Where applicable, data is displayed for each RCC with a total at 
the end of the table. 
 

Data Columns Table One 

RCC Name 

Total RCC Expenses (Operational Costs) 

Cost of Disposal 

Disposal % of Total Expenses 

Total DNR Expenditures 

Estimated Cost Eligible Pounds Disposed RCC(this 
is just your disposal cost/eligible lbs) 

Estimated Cost Eligible Pounds Disposed DNR(this 
is your reimbursement /your eligible lbs) 

Percent of Operational Cost Reimbursed 

(again your total costs/ amount reimbursed) 

Eligible Waste Collected (could include Anti-Freeze, 
others handled locally) 

Non-Eligible Waste (Scrap Metal, CRTs, Sharps) 

Hazardous Waste Collected (shipped to a Licensed 
Haz Waste Contractor) 

Total RCC Operational Costs/Lb (Your operational 
costs/total lbs-all you took in) 

Table Two 

RCC Name 

Number of Households Served 

Pounds per Household 

Number of CESQGs 

Pounds per CESQG 

Total Pounds 

Latex Paint 

Used Oil 

Lead Acid Battery 

Brown Goods 

Other Locally 

Total Managed Locally 
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Tips For Success #9: The Dynamic Cumulative Report 

The dynamic cumulative report viewer allows users to aggregate data 
across multiple collection centers, reporting periods, and materials 
allowing for much more sophisticated analyses of the information.  
To begin, click the link in the instructions on the View Cumulative 
Reports page (circled in red below): 

 

A wide selection of parameters will appear.  To choose multiple selections, hold down 
the Control key while clicking on the desired choices.  When all selections have been 
made, click the Run Report button. 

 

When Run Report is clicked the results will look similar to the Collection Report Form.  
A plus sign (+) may appear next to some rows indicating that the user can click on the 
+ to “drill down” to get more specifics.   
 
You can save the report results using the Export feature at the top of the report.  PDF 
and Excel are among the formats available.  The export will not keep the + buttons for 
drilling into the details but will save any details currently viewable on the screen.  The 
same is true when printing the report – only the detail currently viewable on the screen 
will be printed. 
 
 
  


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An example report is below using the selections shown on the previous page.  This 
report shows the information for two Regional Collection Centers for the period of 
July 1, 2008 through June 30, 2009.  Material Categories Flammable and Reactive are 
displayed.   

You can see the + button next to Appanoose County Transfer Station has been clicked 
so that the detail for that RCC is shown.  In that detail, the + button next to “Total for 
Reactive” has also been clicked so that you can see the materials that are included in 
that category.  Cass County has no detail displayed so it only shows the total material 
collected for each column (Note this total is the total for ALL materials, not just those 
in the selected Flammable and Reactive categories.  This is clearer when you drill down 
into the details.). 
 
In addition to selecting individual materials and material categories for display, you can 
also choose which of the columns should appear on the report.  If you are only 
interested in the Total Hazardous Management and Total Non-Hazardous 
Management you can select to have just those two columns. 
 


